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SHOOTER TRAINING SYSTEMS

SCATT WM9 / WS1 / USB

USER MANUAL

Please read this manual to its end
to secure safety and best quality
of the system’s operation.



Dear Customer, thank you for buying this system. Please read this manual to its end
to secure safety and best quality of the system’s operation.
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Please check and identify all supplied accsessories

Bl

1. Electronic target WT-01

2. Electronic target control unit WTC-01
3. Optical sensor WS-MO01

4. Software CD

5. User guide

6. Electronic target control unit interface cable

NI NI

7. Electronic target interface cable
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Please check and identify all supplied accessories

1. Electronic target WT-01

2. Electronic target control unit WTC-01

3. Optical sensor WS-03

4. Mounting parts set

5. Software CD

6. User guide

7. Electronic target control unit interface cable
8. Electronic target interface cable

9. Optical sensor charging cable

NI




Please check and identify all supplied accessories <

1. Electronic target ST4-12

2. Electronic target control unit WTC-01

3. Optical sensor OS-02

4. Mounting parts set

5. Software CD

6. User guide

7. Electronic target control unit interface cable
8. Electronic target interface cable

9. Optical sensor interface cable

NI &

System installation

Software installation

Before using SCATT system, you need to install SCATT drivers and software.

Insert disk (provided in a set) in the CD-ROM drive, select SCATT. EXE icon in the
disc drive window and follow instructions on the screen (fig. 1).

Install drivers before attaching SCATT devices to the computer, then attach all
devices one by one.

]it.zl Setup - Scatt Shooter Training System ;IQIEI

Welcome to the Scatt Shooter
Training System Setup Wizard

This will install Scatt Shooter Training System 6,17 on wour
computet,

It is recommended that vou close all other applications before
conkinuing.

Click Mext ko continue, aor Cancel ko exit Setup,

Cancel |

Fig. 1

While all necessary software is included on CD, we recommend to download latest
versions of software from http://www.scatt.com.




System installation Optical sensor 0S-02 / WS-03 installation

Electronic target installation 0S-02 optical sensor connection

Install electronic target on a tripod (photo tripod) or fix it on the wall at the distance Connect optical sensor model OS-02 to USB port of your computer by standard USB
from 3 to 6 meters for SCATT WM9 model and from 4 to 10 meters for SCATT WS A - mini B type cable (included with your kit).

and SCATT USB models so that the LEDs face the shooter. Insert a paper target,
but make sure it doesn’t cover the LEDs. Connect electronic target to USB port of
your computer as shown on a scheme.

1 - OS-02 optical sensor
2 - USB A - mini B cable
3 - USB connector

0oQo Infrared LEDs o @7—8 o

Paper
target

Wall-attaching holes

Paper
target
fixators

WS-03 optical sensor connection

Optical sensor has a two-way infrared connection with the electronic target. Sensor
has a built-in battery and can be recharged from USB port of your computer. Full
charging cycle is1.5 hours. Operating time of a fully charged battery approximately 30
hours of non-stop aiming or 10.000 shots (with an average time 10 sec. Per shot).

000 Mutticolor LEDs In case of non-use, the sensor automatically switches to sleep mode.

1L

Target number
switcher®

*(used only when more
than one target E — —
connected) Ooo

I 0 T L S

ooQo
—\%Llnfrared receiver
(WT-01 model only)

Electronic target WT-01

1 - WS-03 optical sensor

2 - USB A - mini B cable (for charging)
3 - LED charging indicator

4 - USB connector

Extra electronic target
connector

SCATT trigger sensor (not included in the set) can be plugged into the USB
connector of WS-03 optical sensor.

Nut for photo
tripod fixation

Clamp position adjusting

Electronic target control unit You can change clamp position on optical sensor body.
WTC-01
1 - Optical sensor body
2 - Clamp
4 0[E=HE 3 - Clamp fixing screw
Connect to USB port of your PC PC




Optical sensor 0S-02 / WS-03 installation Optical sensor WS-MO01 installation

Installation sensor on the barrel Installation sensor into the 9 mm barrel

* Insert the optical sensor into a 9mm
barrel
(The barrel must be clean and dry).

Installation options:

* Mounting the optical sensor on the
barrel or gas cylinders using the

mounting prism and plate with screw )
1. Optical sensor WS-MO01

2. Battery cover (Tighten firmly)
3. Battery (1.5V — SW393SR)
4. Rubber O-ring

* Mounting the optical sensor on short
barrel pistols using barrel inserts of
various calibers

Optical sensor has a two-way infrared connection with the electronic target.

Operating time from one battery (1.5V — SW 393 SR) about 10,000 shots (with
an average time of sighting 3sec)*.
In case of prolonged non-use, the sensor automatically switches to sleeping mode.

Warning!
Observe the battery polarity. To avoid battery discharge, store sensor away from
strong lights or direct sunlight. With long-term (more than a week) non-use the
sensor, please remove the battery.

1 - Optical sensor ) ] .

2 - Mounting prism Before using the sensor, make sure the firearm is not loaded!

3 - Mounting plate with screw Don’t forget remove the sensor from barrel after training.

4 - Barrel of a gun
5 - Barrel insert (not included in a set)
6 - Short barrel pistol

*To achieve the stated performance, we recommend using battery of the following
manufacturers: RENATA, DURACELL, ENERGIZER, VARTA, GP.
We do not recommend the use of zinc-air batteries are labeled "PR".




Optical sensor WS-MO01 installation Operating SCATT / Basic operations

Installation sensor on the barrel Starting SCATT

For fixation of the optical sensor outside the barrel extra mounting parts are required When hardware and software installation is over, select SCATT icon in a program
(not included with your Kkit). manager to start the program (fig. 2).

Installation options:

+ SCATT Professional =0l x|
] Ele Edt Shooting Yiew Tods 7 H [@)start Wropen Gevodel & B | BEshotist $Esedes | B TR | @

* Optical sensor fix on barrel (or gas
cylinder) using mounting prism
and plate with screw.

G SYSTEMS ¥, Q.

+ Optical sensor fix on barrel using
barrel inserts of various calibers.

3 & Scatt Systermn is a Computer aided training accessory for shooters. An extremely safe system works on a
1‘ Opt[ca/ sensor WS-M01 dry fire _ba5|s of can be used with air pellets and allowes individual shooters to be able to physically see what is
happening at the end of the barrel throughout the whole shot,

2. C/amp Sg Mot only can you see the results of your shot after it has been taken but you also have the opportunity to

. . [ —— see what is happening while you are actually aiming at the target. The Scatt systemn was developed to assist
3. Mountlng prism Start practice shooters from all aver the warld ta enable them to reach their highest goals.

I I It helps to develop a shooter's ability to achieve very high scaores in shooting competitions, which in sport
4' Mountlng plate Wlth screw shooting is the primary objective. & seties of easy to understand graphs enable you to assess exactly what
5 Barrel o happened, what your problems are and the best course of action to take.
6. F/xmg screw Additional information

Open document
wisit our weh site at the address www.scatt.com for additional information, software updates and support.

Optical sensor capture area

[-]
To achieve the best results, use an Press F1 for belp 4
optical sensor within the work area. Fig. 2
Printing paper target
1. Electronic target
2. Optical sensor Before starting a new training, you need to print out a paper target, corresponding
to the desired distance, and exercise (program allows you simulate shooting at

distances up to 1000 meters).
To print a custom paper target, connect printer to your computer and select
“Print target” option in “Tools” menu of the SCATT program control panel (fig. 3).

1 -Ioix]
/ J File Edit Shooting  View ’E ? || Start @Open @Model % u | S Shot st 58 Series ‘ ﬂ '@ | @
0, Frink target...
9 : .
% 1 Reset hardware  Chrl+H Flg 3
Q/ @' Shots parameters,..
/ A options...
0.

* Distances for optical sensor
models 0OS-02 and WS-03




Operating SCATT / Basic operations Operating SCATT / Basic operations

+ Start Practice J x|

Scatt connected te: IScatt Wirgless #1 j

In this window (fig. 4) you need to select the exercise (target and simulated distance)
and enter the distance to electronic target and then click "Print" button.
The printed target will correspond in scale with the distance to simulated target.

Shooter Name

Cut and paste it into paper target fixators of the electronic target as shown on a

. s . Shiat B Jahin Smith -
scheme (see electronic target installation). aE IO, B

Print target tool |

Ewent: Preview

5 Balkenscheibe horizontal (3.0 mm

5m Balkenscheibe vertikal [ Shooting exercise
Sm GLOCK1Y (5.6 mm)
Bm Ovalzcheibe [9.0 mm)
B MWD [9.0 mm)
10m Air Piztal [4.5 mim)

10m Air Rifle (4.5 mm)

10m &P Blank. target (4.5 mm)

10m AR Blank target [4.5 mm)

10m AUG_A2 (9.0 mm)

10m Balkenscheibe harizontal (3.0 rm]
10m Balkenscheibe vertikal [3.0 mm)
10m Ovalscheibe (9.0 mm)

10m Running target (4.5 mm)

Drarte (1.0 rmm)

F.onigzcheibe (4.5 mm)

12m Smallbore Rifle (5.6 mm)

15m Balkenscheibe harizontal (3.0 rm]
18m Balkenscheibe vertikal [3.0 mm)
15m MWD [9.0 mirn)

KT 2
Target type ISCATT Salution 10 meters j

Distance to electonic tanget I[\ 5_|; meters

¥ Print score rings

Target preview

V -

Openlclose viewing area button

‘ Distance to electronic target ‘

Frint | Cloze |

Fig. 4

New practice starting

To start training, push “Start practice” button or select “Start practice” in “File” menu.
In the dialog box (fig. 5), select exercise, type name of shooter and press "Start"
button.

Event: ¥ IS5F v Miltary W Other

5m Balkenscheibe horizontal (3.0 mm)
am Balkenscheibe vertikal [9.0 mm]
Srn GLOCKAT (5.6 mr) 10m Ovalzcheibe (9.0 rmm)

i Owalzcheibe (9.0 mm) 100 Runining target (4.5 rim)

8 VD (3.0 mm) Drarts (1.0 mm)

10m Air Pigtol [4.5 mm) K.onigecheibe [4.5 mm)

10m &ir Rifle (4.5 mm) 12m Smallbore Rifle [9.6 mm]

10m AP Blank target (4.5 mm) 15m B alkenscheibe horizontal (3.0 mm)
10rm AR Blank target (4.5 rim) 15 B alkenscheibe wertikal (3.0 mri)
10m AUG_AZ (3.0 mm) 15m k%0 [3.0 mm)

i | =

10m B alkenscheibe honzontal (3.0 mm)
10m B alkenzcheibe wverikal (9.0 mm)

Shooter exercises

Start I Cancel |

4
Fig. 5

Optical sensor calibration

After you clicked on "Start" button, SCATT calibration window will open. In this
window (fig. 6) you need to calibrate the optical sensor (to match the axis of the
optical sensor and sights) and make necessary adjustments.

Optical sensor automatically measures the distance to the electronic target. The
program allows you to automatically calibrate the sensor relative to the sighting of
weapons, so there is no need to adjust the sights of weapons. Sensor automatically
compensates for the “blockage” of weapons!

Optical sensor contains high frequency ceramic microphone which registers the click
of your weapon triggering mechanism.

To make optical sensor calibration, aim at the target and make one blank shot.
Shot-hole should be displayed inside the work area. If shot-hole does not get inside
the work area, check if the sensor’s axis is parralel to the axis of the barrel.

If sensor doesn’t respond to trigger click (doesn’t display a shot-hole), reduce the
trigger response regulator value.

Attention, electronic target start with 10 second delay (this time needed to charge

capacitor inside). -



Operating SCATT / Basic operations

o Scatt calibration x|

Make a shot a5 close ta the center of the target a5 possible. Make sure it is displayed within the inner circle [working area) on the screen.

Optical sensor Working area
aiming point

Distance to
electronic
target

Electronic target

signal level

Battery charge level
(only for wireless
optical sensors)

Aiming point
displacement
indicator

Battery: 60% (1.41%), Distance: 4.17 m

; "
Piczo sensiivity: 13.1% / Trigger response level regulator’
i =

1]

Leds brightness; & ‘ Multicolor LEDs brightness regulator K

Lamps brightness: 5

LED lamps brightness regulator**
P
*Smaller value of this regulator make sensitivity to trigger response higher. Fig. 6

** Used only if your electronic target have built-in LED paper target lighting module.

When calibration is completed, close window by pressing "Close" button. SCATT
program will interpret your shot-hole as center of the target form.

Window "SCATT calibration" may be opened at any time by select “Adjust Optical
Sensor” in “Shooting” menu or by “F2” button pressing.

Practice window (sighting mode)

When you aim at the target, your aiming trace (movements of your aiming point) will
be displayed in real time, the click of triggering mechanism registers as a shot.
Program calculates shot-hole position and displays it on the target (by using aiming
trace speed and ballistic coefficient).

After the shot you can replay of your aiming trajectory and shot result.

Shot list contains targets with grouped shot-holes (default grouped by 10) and
information about each shot (result, aiming time, aiming trace length and etc.).

16

Operating SCATT / Basic operations

J Fle Edt Shooting  Yiew Took 7 H @stop 3P imach Bopen Ehodel & | 2%chotlist @ Series ||§‘ jial | ()]

Shat list x ‘ omfo ‘ﬂTrace ==D\stance ﬂ[ourdlnatmn + Shift  Tyspesd .Intervals uPrDhablhty
Lo
Control panel ]
Target area
= Sighting mode indicator

FANPR—-

0y P
q ’\f/‘*‘”'
¥

+ John Smith - AP10* - SCATT Professional =131 x|

R Replay | & sightings  ¥%6# All braces

10.0 Length
20%
E1%
807
53%
467
3%

67 71:1 ﬁ:ﬁ 43% 12T:I] ’
)

‘ o

|Prass F1 for help

Mid-point of aiming

A

Fig. 7

Use electronic corrections

You can use computer mouse to make shot-hole position correction.
Move mouse pointer on the last shot-hole (it takes form of palm) and pressing left
mouse button, drag the hole to the desired place (fig. 8).

Corrected
shot-hole

Fig. 8

We don’t recommend use of electronic corrections in case the shot-holes are
grouped further than the 8th ring. In this case it is best to repeat sensor calibration.

When you are satisfied with the sighting shots results, you can move to “Match”
mode. Press “Match” button on the control panel.

17



Operating SCATT / Basic operations

Scaling the target

During training you may need to change the scale of the target is displayed on the
screen. You can change the scale of the target by pressing the numbers keys

(1 through 0) on your keyboard, pressed numbers correspond to the target score
rings.

It is possible to change target scale by double-clicking on select score ring area, by

pressing right mouse button you can reset scale.

Also you can change scale of shot list group targets by pressing “Ctrl” + “1 to 0”
number buttons.

You can move on-screen area with mouse while holding down left mouse button and

“Ctrl” key on your keyboard.

Also possible to increase rectangular area on the target by selecting it while holding

left mouse button.

Practice window (match mode)

In “Match” mode (fig. 9) all features of program is available.

& John Smith - AP10 - 4/27/2012 2:48:40 PM* - SCATT Professional | 3
J Fle Edit Shooting Wiew Tools 2 H Qstop 3 Fopen Fvode S H ‘ $% shot st &3 Series |I§ izl | [CN]

Shot list x| [ JO \ﬂwace S Distance  ~JFoordination  * shift ASpeed  (Mlintervals Lo/ Probability
RrReplay & siohtino: ¥ alltraces

ZeeEEn o
# Hesult Time 10.0 Lengtl

" 90 43 0% 28
12 1us] 11,3 2% 50,
13 03 108 B7% f=is)
14 m3 73 83% 24
15 mno o 71 70 48,
16 93 &5 13% 48,
17 95 43 56 74
18 oz 70 50% 34
53%

|Press F1 For help

18 Fig. 9

Operating SCATT / Basic operations

For ease of analysis, after shot aiming trace is drawn in different colors corresponding
to various time intervals:
» Green - when you start aiming
Yellow - one second before shot
* Blue - 0.2 second before shot
* Red - after shot

Control panel

During training shooter can control some functions of the program, using the control
panel (fig. 10)

+ John Smith - AP10 - 5/2/2012 1:39:21 PM* - SCATT Professional = |EI|5|

|I'Fle Edt Shooting Vew Took 7 “ Osiop 32 BSopen Ftodel S I || Srchoie seres | B W | @

Start Practice, . Ghrlbh
[ Open... ctrl+o - -
i Switch display mode Sound On/Off
K s e to series of shots
- Contents of “File” menu
[Z Open model...
Close model
&} print... Chrl+p
@ Print Preview
Print Setup...
Send to L4
Exit Alt+F4
Fig. 10

Contents of “Edit” menu (fig. 11).

+ John Smith - AP10 - 5/2/2012 1:39:21 PM™ - SCATT Professional
J File ’E Shaoting  View  Taools 7 “ € stop % ﬁOpen @Mode\ % u |
2 Hide: shot
Delete sighting shots Flg 1 1

Delete all shats

~=1ol x|

$8 Series ‘ B i@ | [CN]

S shot list

Contents of “Shooting” menu (fig. 12).

+ John Smith - AP10 - 5/2/2012 1:39:21 PM* - SCATT Professional i =10 ﬂ
J File Edt | Shooting View Took 7 || Sstop 3 Bopen Evodedl & B | SEeharis $Esenss | B W | @

R Replay Space

&5 Replay all shots Flg 12

% adjust Optical Sensar...  F2
'.'E': [Aatch 5

Reset trace target Enter
» Cantinue.

Prone
Standing

Kreeling

Q Stop Practice

19



Operating SCATT / Basic operations Operating SCATT / Basic operations

In “View” menu (fig. 13) you can select display mode (simple or advanced) of the ] W
program, change menu language. Saving training results

« John Smith - AP10 - 5/2/2012 1:39:21 PM* - SCATT Professional =10] x|

| Fie Edt chosting [wew Teok 7 || @50 P Bopen Gt & B [[3Eshoti: 285eres | W | © SCATT program automatically save shooting results in the directory where the files
lv Acdvanced moce Fig. 13 are grouped under the name of exercise and names of the shooters.
2% shotlist ' You also can print out training result.

33 Series

€ ceneralinfo F4 .

(@ Trace Fs Opening saved result

&% Distance araph F6

gk Coordination F7

+ st o To open saved result slect “Open” in “File” menu of toolbar or press “Open” button.
& el In opened window (fig. 16) select exercise, shooter name, shooting file and press

. Time Inkervals  F10

|+ probabiliey F1L Open .
oo x|
- = 10m &ir Pistol [4.5 mm) Diake & time | Position | shu.. | Result| i
© Display sightings Smi 27042012 14048 21 199
¥ Display all traces
Display hidden shots
Eadaas ’ {21 CMupHoea CeeTnaHa
Full Screen F1z []"D 10m Air Rifle (4.5 mm)
-2 25m M4 9.0 mm)
« » - B 50m Rifle (5.6 mm)
Contents of “Tools” menu (fig. 14). 1 Air Pistal
+ John Smith - AP10 - 5/2/2012 1:39:21 PM* - SCATT Professional ] =10l x| -0 &ir Rifle
| Fis Edt Shooting View | Toos 7 || @stop 3 Eopen CEtodel & B [[TEsnori S8 | @7 % | @
Print target...
Reset hardware  Ctrl+H Flg 14
B shots parameters. ., ! I I ﬂ
wm”— Hper I Cancel |
4
Contents of “?” menu (fig. 15). Fig. 16
In “Help” tab, you can get information about some aspects of the program.

+ John Smith - AP10 - 5/2/2012 1:39:21 PM* - SCATT Professional ) — Ol x|
J File Edit Shooting View Tools |—?| ‘ @stop 3 BSopen Fvoddl & B || $2chotist $Sseres | B ¥ | @
(2] Help F1 )
SCATT on the Inkernet Fig. 15
About. .,




Additional features of the program

Not only can you see the results of your shot after it has been taken but you also
have the opportunity to see what is happening while you are actually aiming at the
target. The Scatt system was developed to assist shooters from all over the world to
enable them to reach their highest goals.

It helps to develop a shooter's ability to achieve very high scores in shooting
competitions, which in sport shooting is the primary objective. A series of easy to
understand graphs enable you to assess exactly what happened, what your problems
are and the best course of action to take.

Some program features are not available in the "sighting" mode. To activate all
features, switch program to “Match” mode.

General Info

This screen (fig. 17) shows the general information about the shooting file, as well as
the loaded model. This is the place where you type in the shooter name and
comment. The following items are displayed:

Shooter name

Comments

Shooting event name

Date and time of the first match shot

The number of match shots.

Integer result.

Fractional result (all shots are scored as in final).

Averaged shot result.

Result for the shot group in relation to the center of the target

Total shooting time: an interval from the beginning of first shot to the end of last shot.
Average time for a shot.

Stability of time interval between each shot (if all shots are equally spread the stability
is 100%).

Diametrical dispersion: a center-to-center distance between two most distant shots.
Stability of aiming: average points of the tracing are taken for a given interval of time
before the shot, and the diametral dispersion of these points is calculated.

Accuracy of shooting: the average point from the points described above is calculated
and its distance from the center of the target is measured.

Average steadiness in 10.0: shows the amount of the final analysis ( control ) time up
to the moment of shot release that the aiming point was within the 10.0. It is
expressed in percentages.

Average length of a tracing.

Elliptical factor (for shots): it is a ratio of averaged shot dispersion diameter on x-axis
to that on y-axis.
Elliptical factor (for tracings): the same as above but for tracings drawn on the target.

+ John Smith - AP10 - 4/27/2012 2:48:40 PM* - SCATT Professional =10 5[
J [ 5tart  [Fopen EModel & | 85 shotlist  §3 Series ‘ B | (]
0Info oTrace == Distance  ~JCoordination  + Shift  :Speed (il Intervals Mpmbab\hty

JEi\e Edit Shooting  View Tools 7

Shooter name

[aehn Smith

Comments

My first ZCATT practice

Shooting event 10m Air Pistal (4.5 mm) (AP10)
Date, time 4272012 2:48:40 PM
Number of match shots 21
Result integer 199
fractional 206.9
average 9,852
Result for the shot group in relation to the center of the target 215.0 (+2.1)
Total shooting time 00:08:18
an interval from the beginning of first shot ko the end of last shat
Averane time per shot 00;00;18 (00;00;12, 00:00:30% LI
|Press F1 For help 4

Fig. 17

Distance curves

Distance between aiming point and the center of the target for the selected shot
(fig. 18).

Three curves are drawn (vs. time) in the graph:

absolute distance from the center

distance from the center along the X-axis (axis of abscissas)

distance from the center along the Y-axis (axis of ordinates)




+ John Smith - AP10 - 4/21/2012 2:48:40 PM* - SCATT Professional ] & John Smith - AP10 - 4/27/2012 2:48:40 PM* - SCATT Professional
J File Edit Shooting View Tools @ H Start Dquen HqMode\ % u | S%chotlist 3§38 Series ‘ @‘ T@ | ® J File Edit Shooting  iew Tools 7 H Start D’\‘Open @Mndel @ E | S shot list  §3 Series ||ﬁ‘ @ ‘ ®
@i @Trace | @80istance ~FCoordination  + Shift <uSpeed filIntervals L/ Probabilty @rio Trace E0stonce | wrCoordination * shit <uspeed  (MlIntervals | Probabilty

WDisplacement along the »¥-awiz  MDisplacemert along the T-axis WCoordinatior: 21 match shots - MModelk O match shots

Distance

Time before shot [sec)
-1 09 08 07 06 0.5 0.4 0.3 0.2 -01 o1 0z 03

g
BAbsolute distance /\/

2
= <¢,
=

Time before shot (sec) Time before shot [sec)

-1 09 08 07 06 05 0.4 03 0.2 01 01 0z 03 1 Rik:] 0.8 07 06 05 04 03 0z a1 01 nz 03
|Prsss F1 For help v |Press F1 faor help v
Fig. 18 Fig. 19
L smaw
The term co-ordination (fig. 19) means the ability of the shooter to choose the optimal In this diagram (fig. 20) the dependence of shooting result on the moment of shot
moment of shot release within his ( her ) ability of holding steadiness. This is one of release is displayed. The plot shows what the result would have been if the shot had
the most important criteria by which the shooter's ability as a competitor can be been released at some earlier moment.

judged. This ability to choose an optimal moment of final shot release can partly
compensate for insufficient steadiness.

Co-ordination is analyzed by averaged curve of the values of () = X i+ i (i,
It is plotted in some time interval prior to the shot. The value of R(t), and in particular
the character of the change (increase or decrease) in the final 0,2-0,3 second, are

characteristic of the degree of co-ordination ability of the shooter. The faster the R(t)
value grows in last 0,2 second, the lower the shooter's co-ordination ability, i.e. more
likely the aiming of the rifle or pistol becomes worse in the final moment of triggering.




+ John Smith - AP10 - 472772012 2:48:40 PM* - SCATT Professional )
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J File Edit Shooting  Wiew Tools 7 H Start DWODEFI @Mude\ é u | S5 Shot st 3 8 Series ‘ @ T@ | @
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D \/
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Result
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]
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Time before shot [sec]
g B 04 08 07 LB -0.5 0.4 03 0z 01 01 02 03
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Time before shot [sec)
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‘Press F1 for help v Press F1i For help v
Fig. 20 Fig. 21

Aiming point speed curve Time intervals graph

In the time diagram (fig. 22) the height of the bars represents the shot value and the
distance between bars represents the time intervals between shots. This diagram
shows parameters such as the stability of shooting rhythm.

A graph of average speed of aiming point movement versus time (fig. 21).
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J Ele Edit Shooting  VYew Took 7 H Start @Open @Mudal é E ‘ S shotlist 8§ Series |§‘ T@ | ®

rfo €emrace gpDistance S Coordination  + Shift  iSpead | Mlirtervals | L/ Probahiliey
WFirst shot 4/27/2012 2:48:47 PM - BLast shot 4/27/2012 2.54:57 PM
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Probability graph

Evaluating the effect of the rifle and cartridge (bullets) quality on shooting results
(fig. 23) To test firearms and cartridges the following method is used in Russia: from a
rifle fastened in a special bench 6-8 series of shots ( ten shots per series ) are fired.
In each series of shots the distance between the centers of two most distant shot
holes is determined (the Dmax10 value). The worst (maximum) value of Dmax10 of
all the series of shots is considered to be characteristics of quality of the rifle and
cartridges. The Dmax60 value for all 60 shots fired to the same target is the second
characteristics. In accordance with this method the Dmax10 and Dmax60 values for
electronic-optical training systems may be taken equal to nil. By selecting a bullet
dispersion model in the program and changing the Dmax60 value in the program it is
easy to estimate the effect of rifle and cartridge quality on shooting result.

An opportunity to show the above method is available in the SCATT training system
software. The bullets dispersion model is based on normal (Gaussian) distribution
function (as a first approach), and it allows the change of Dmax60 value with small
increments.

Sampling (from the model) is performed according to random law.
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Two displaying variants are provided. In the first one the change of overall shooting
picture with recalculating the result is displayed; in the second one the probabilities

of a result greater than or equal to the initial result as well as an averaged one are
drawn on the diagram depending on the growth of Dmax60. In this case, for larger
number of random samples taken from the dispersion model, averaged figures of the
said values are taken for each of the Dmax60 values.

Analysis of curves drawn for several shooters allows you to draw some conclusions
which might appear at first sight to be unexpected. Most shootings have some interval
of the Dmax60 values, not equal to zero, in which there is high probability of reaching
the result that is better than at Dmax60 = 0, i.e. with worse cartridges (bullets) it is
possible to obtain better result than in case of ideal cartridges (bullets).

The second conclusion is that it is not always reasonable to try to use more expensive

cartridges (or bullets) since in this case the expected improvement of the result may
not be reached.




To compare two training, during analise saved shooting file, select “Open model” in In this menu (fig. 25) you can change some parameters of program.
“File” menu or press “Model” button on the toolbar. SCATT catalog will open. Select

file for compare and press “Open” button. x|
Models information will be displayed on graphs by red color (fig. 24). e
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Shots parameters menu

In this menu (fig. 26) you can change following parameters:

* Bullet dispersion - changing this parameter, you can add value to the existing spread
of fire to assess the result of the real picture, you can get using a bullet with a known
value of the scatter

» Shot moment - changing this setting you can see what would result if the shot
occurred before or after a while

« F Coefficient - ballistic coefficient (angular velocity multiplied by the flight time)

« Control interval - time before shoot for which analysis is based

« Coinside grouping with the center of the target - trasfer center of your shot holes
group to center of the target.

Shots parameters x|

Short keys

[ Coinside grouping with the center of the target
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Ctrl + N New practice
Ctrl+ O Open file
Ctrl + P Print practice results
Ctrl+S Save practice results
F1 Help menu
SPACE Replay aiming trace
F4 Info menu
F5 Target with trace
F6 Distance graph
F7 Coordination graph
F8 Shift graph
F9 Speed graph
F10 Intervals graph
F11 Probability graph
F12 Full screen mode

Troubleshooting

Software reports
“SCATT device not fund”

Make sure all SCATT units are connected to
the computer, SCATT drivers are installed

No signal from optical sensor

Either the target or optical sensor are not connected,
distance to electronic target has been selected
incorrectly. Recharge or replace optical sensor
battery (depending on model of optical sensor).
Check all connections, restart SCATT program.

When optical sensor
enters the target area,

it results in a spontaneous
shot

Adjust trigger response sensitivity of optical sensor

If given recommendations don’t help solve your problem, consult the Service Center.

Clean this device with soft dry cloth. If the surfaces are too dirty, use soft cloth, wetted
in suds or in mild soap detergent solution. Newer use solvents or petrol to clean the

device.

Specifications

Optical sensor weight:

Electronic target dimensions:
Type of radiation:

Operating temperature range:

0S-02 - 30g (with mount)

WS-03 - 33g (with mount)
WS-MO01- 8g (with battery)
H 234 x W209 x D32 mm

IR radiation of 900 nm

+5to +37 °C

Specifications can be modified by manufacturer without being worded in this manual.
Weight and dimensions are approximate.
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